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RSA/P Best Practice, StarTeam

Application

StarTeam is not a tool developed with only Ericsson’s business in mind, it is a
global system used all over the world. StarTeam can be used in many, many
ways. This document will guide the developer in the usage of StarTeam with
regards to Ericsson standards.

This document is divided into two parts. The first part of this document is a
step-by-step guide with examples and explanations. The guide includes
creation of projects, setting up of views and revision control with the help of
labels.

The second part is a reference document containing the RSA/P specific
structure. Developers already familiar with StarTeam should use this
reference part as a template for creating and maintaining projects in
StarTeam.

Document coverage

This document does not, nor is it intended, to cover all aspects of StarTeam
usage. In order to get familiar to general StarTeam functionality you should
attain a StarTeam course. There is also other reading materials available at
RSA/P including:

Printable manuals (PDF format, located using the SW-platform interface)

e StarTeam Getting Started

e StarTeam User Guide

* Best Practice Documents from StarBase

Books (each NPI-section has two copies)

* Practical Software Configuration Management
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PART I: USING STARTEAM ACCORDING TO RSA/P NORMS (STEP-BY-
STEP INSTRUCTION).

INTRODUCTION

StarTeam uses a standard check-in/check-out system for revision handling.
Ericsson companies using StarTeam all have a central server commonly
referred to as a repository. Technically, this repository is a database where all
files (and their different revisions) are stored.

StarTeam provides an easy to use interface between this database and the
developers local hard-drive. A default working directory is specified for each
database by the StarTeam administrator. At RSA/P this directory is
C:\PROJECTS.

Simply speaking, StarTeam takes care of the synchronisation between your
local C:\PROJECTS folder and the global database. If you change a file in
your local working folder, and would like other people to access it, you must
CHECK-IN the file to the database. If you find a file you want in the database,
you should use the CHECK-OUT function. This function retrieves the file from
the database and stores it in your local working folder.

GETTING STARTED

Make sure you have StarTeam correctly installed and configured. Refer to the
StarTeam installation instructions in this guide for more information. If you
have installed StarTeam correctly the screen should look like this:

+: StarTeam 4.1 HEE
Project Toolz Help

0=

| Far Help, press F1

B

CREATING A STARTEAM PROJECT
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Projects are the most essential part of StarTeam. Most of the RSA/P specific
norms are applied at the project level.

Choosing the right StarTeam-project implementation

RSA/P uses StarTeam in special way that is not fully supported in the current
StarTeam version. StarTeam is designed to manage a few very large
projects, but here at RSA/P we have many small/medium sized projects and
even project-independent programs. In order to avoid “overflow” in the
StarTeam-project selector, one StarTeam-project is created for each
department within the RSA/P. Subprojects are then created within each
department in the form of floating views.

For large projects a separate StarTeam-project can be created. Contact your
local StarTeam administrator for more information on this subject.

Create a new small/medium size project

Select Open... from the Project menu. If you have configured the server
settings correctly a server name (StarTeam Gavle) should appear in the Open
dialog. Select you department and click Next.

Open Project Wizard: Select Project HBA

Select the praject to be opened. |f wour praject is stored on &
(2] zerver that is not in the list, click &dd Server... to add that

Terver
j Add Server... |

Delete Semver, |
Serven Broperties |

: .27 DRt RSAMPITL
Project ~a0bp <

[ T T

Wizar d Click Finigh to open your project.

< Eﬁregéendel Masta > I Slutfar | Avbryt |

In the next dialog box you are presented with a number of so called Views.
Each view is a subset of the complete database. If you would like to create a
new project, select the RSA/P/TA view (the root) and click Finish.
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Open Project Wizard: Select Yiew HEB

Select a view:

Starfeam® View name:
= [ Projects [Rsasp/TA
[:' Mesus
E|[:| Testprograms Yiew description:
=-[E3 CAL 1203521 [RSAPTA =
L2 RIE
Pro ject S|
Wizard Click Finizh to open your project.

<Eciregéende| Estea | Shutfar I bt |

NOTE: The Projects and TestPrograms views/folders are part of the
StarTeam RSA/P standardisation and should always exist within each
department.

The next step is to create a new folder (and a new view) for the project. Make
sure the Projects folder is marked. Then select the New option from the
Folder menu. In the first dialog box, click Next, then enter the name of the
Project and a description:

Lirsis Hew Fabler Wissid Gpescily M ame s ednipdisn

Fumscd Inkds s | Foowa:

LT:MW.-:-JM'ddﬂa-Iuﬂlwlmlummml

1 Wy Dol e rod ponar, ST s ol conite i o s s B 0 i

Il pos i ool el i, SdanTmarn own e propci iolder rees a e

ey o e e kokched
hrk g bakde
I e |
Rrks & dercapion k(B ree e
Hemn. ned geesralion FFT L bl concasd]
1 [owgplarca | P | e

Click Next> and then Finish.

Creating your project View
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This step is very important with regards to the RSA/P StarTeam norms. Select
the newly created folder and access the popup-menu with a right
mousebutton click. From the popup-menu select New View.

Horm ¥inss Wil 5 pecis Ves Pogaiiae

e i Bt et 1S P e

P Lo e e birw vl s
Dy

W Emnidew by brarch sibe b ves

Culed faar bawe g

i e cdmdrmrsse e il B wchir s babarvicd lon e @ e ress
e s Bl e oL coanied s Beeecheng babavecs com b wadded
wndeparedends bod aach pawn

T Barchgl

7 b

[[(memss | it |

Now, make sure the Permit items to branch item is selected and that the
default item branching is set to Branch none. All project views should have
these properties, since they are floating configurations (in order words, if you
later change something in the subviews of the project, this view will be
updated as well). Click Next.

In the next dialog, enter a name (enter the project name) and a description
(enter the project description). Click Next until the following dialog is
displayed:

StarTeam ]

The zpecified working folder comezponds ta the working folder of the parent view. If both views are used on the zame
computer, this may cause files to be ovenwritten and data to be lost.

would vou like to change the working folder?

Select No at this point since we will not do any individual branching within this
view. In the Next dialog the most important view property is configured. The
Specified configuration should be Floating Configuration:
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15

Hewr Viewm Wirnid Hpeecilp Base el s o

T ey rost o o B3l o o o b bnad| o epecles comiigusiten of B
=T R

“Wh b el conbops n, e oin okl e mea vew boechanpem e

o cLranl v
e i P O R, eyl e e B Caiveed el
S e e pll g mm- el pgx o e rebeveh dew
Ewacib oo s o
& Fting conky amwe)

k] o gl

Frnghere| S | b |

Click Finish. Your project view is now created. When you reopen this project,
ALWAYS select the project view. All changes and labels associated with this
project should be attached to the project view.

NOTE: You can switch views at any time by using the Select View option
found in the View menu.

Create standard folders

Within each project tree standard folders should always be created: Doc,
Install and Source. Create these by using the New Folder option. Within
Install there should also be two folders called Files and InstallShield.

In order to simplify readability and access all project should have the same
base folder structure. It is recommended to use the standard folder, however
extensions and modifications must be allowed to ensure flexibility.

CREATE A NEW PROJECT-INDEPENDENT TEST-PROGRAM

Follow the instructions for creating a new small/medium sized project but use
the Testprograms folder/view instead of the Projects folder/view were
applicable.

All test-programs in the Testprograms folder should have a separate view
(just as a project has a separate view). When naming test-program views, you
cannot use the /-character, instead use the .- character combination.
Example: CAL 120 352/1 becomes CAL 120 352.-1

You should always name the folder and view according to the standard

Ericsson program enumeration (CAL). Standard folders within a CAL folder
are the same as for project folders.

REVISION CONTROL STEP-BY-STEP



EN/FAD 109 240 R1B

ERICSSON 2

151

152

One of StarTeam’s most important features is revision control. StarTeam
supports a variety of labelling methods for revision control: view-, build- and
revision-labels.

ﬂ] Branch Revision: 1.6 -19393-11-19 19:05:51
@l Branch Revision: 1.5-1995-11-19 18:30:20

g Branch Revision: 1.4 -1333-11-19 12:22:45
S-@l Branch Revision: 1.3-1993-1119 181117
gl Branch Revision: 1.2 -1999-11-19 140257
gl Branch Revision: 1.7 - 1993-11-02 0%:23: 48
@l Branch Revision: 1.0 -1933-10-25 12:52:36

Dretail IHistDry Label |Link IReFerencel

Every time afile is checked in, StarTeam updates the internal revision
information for that file. The Labels tab provides the connection between
internal revisions and labels. Internal revisions is displayed in the format 1.1,
1.2 etc, while labels should be used to specify the Ericsson revision (R1B
etc).

Using View Labels

The correct way to use StarTeam in the RSA/P software environment is to
use View Labels to manage revisions. Build and Revision labels are not used
since they disable StarTeam’s branching capabilities.

L Dt FEAPITACAL 130 32§ IC WPioecth A P TR TesdpieCAL T 1 H... MR B
B Po=ct dww fokde Fa [ecr s Hek aifix
O@Fd & “3 B FF 8% M arensa dw 2
-1l CAL 1300 F527 [TEHE] Plarm B | Lochad By | matE_ | =

T (=] D =liighe Cuireni F i)

& ] brotel

= el S0WRE ikl el [ [ 1
— nm=c el i Cameyd gl Foiles O jelen ]
—'_ Tkl ot Cusiird o 3

=l 2 ekl i Lo =
= 2 b al J
o= | Fie | Changs Feguen | Tope | fud |
(& J
- a Fisch Fedmar 1510 1R 15T
=1 il Branch Faramon 157 115916 5N)
B [ew] RIF
' Fasch Fsdamt 14 - TERI-R IR
- ' Evanch e 1.1 - TERT-13IE1T0 T

22

J;I_I_-E-th

B [iew]FiE
‘ru.-l.:n.....|‘-'1-1q"|'-|m*:'.?
l § )] Dol | pestoy ygon [ | Eeleemce |
Fis Help, [t F1 e - Cuand 12Fsisl | e

Since all types of labels only appear in the view they were created, it is
imperative that all work on a project or test-program is done in the appropriate
view (for example the CAL 120 352.-1 or Nexus view).

Attaching a new View label
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View labels are attached by selecting the Labels option from the View menu.
The most common practice is to attach a new view label when a major

milestone is passed. For example the test-program is promoted from R1F to
R1G.

View Label HEA

Label name;
|R1G

L abel description:
Revizsion R1G of CaL 120 35241, Added call to ClearSenialMof]

— Configuration

& Curment configuration

" Configuration as of:  [1993-11-19 j |21:2?:05 =

¥ Use as build label
[ Frozen

(]9 I Cancel |

Make sure the Current configuration option is marked if you wish to attach the
labels to the newest (current) version of the files.

View labels can be moved as long as they are not frozen. Moving a label is

done by usage of the drag-and-drop method in the labels tab (lower right
pane in StarTeam).

Branching a current or old revision
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One of StarTeam’s most useful features is its ability to branch a view based
on view labels. Take this example: the current revision of CAL 120 352/1 is
R1F and the development department wished to add special functions to
revision R1E of the same program. The changes should be made WITHOUT
affecting the R1F release.

This is accomplished by creating a new view based on the view labels
designated R1E. Make sure the root folder is selected (the CAL or project
name). Select New.. from the View menu. Since we don’t want the changes to
R1E to affect the current (R1F) revision, we select the Permit items to branch
option. We also have to set the Default Item Branching to Branch All:

Hew Viswm Wirsid Greecilp ¥asa Meapesilan
Eprnik Pes oy of e rems @A

[ty v vinws ban cumend vises
™ Bt

F P i &y ph et iy vl

Dipball fsn b b

Thix oplon defsrerem b nfal et bebaes (08 bere B e
v ncs e eeea o oeaded B bsrcheng besdhaenne can b meccklesd
iy il gack b

& Bigihy gl
7 Baarsch ogra

[ ] e |

Click Next and give the new view the same name as the revision labels (in
this example R1E). Click Next. Make sure the root folder is selected. Click
Next.

This next step is important to avoid merge problems. A new local working
directory must be entered. In compliance with RSA/P norms the new folder
should have “_<revision>" added. In this example “_R1E”. When fully printed
“C:\Projects\RSA-P-TA\Testprog\CAL120352.-1\" becomes “C:\Projects\RSA-
P-TA\Testprog\CAL120352.-1 R1E". Click Next.

In the next dialog you have to specify the view label that the new view should
be based on. In this example we select R1E:
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Hew Yiew Wizard: Specify Base Configuration

The new view can float or it can be based on a specific configuration of the
curment wigw.

“with a specific configuration, pou can isolate the new view from changes in
the cument view.

With a floating configuration, change propagation between the current and
the new view will depend on the behavior settings of the individual items.

— Specify configuration
£ Floating configuration
& | abeled configuration:

E
(7 | Erarnatinr state. canfiguratians

| I
€ Configuration az of:

|1aaa-11-1a H |21:43:44 =

< Foregdends I Slutfr I Avbrpt

Click Next.

Now you are working in a separate “R1E" view. Changes made to files here
will not affect the previous view (R1B, R1F etc). You have now branched your
project.
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2.1
2.2
2.3
Wiew:
Root view

Created by admin

Wiew:
Frajects,Testprograms
Folder:
Frojects/Testprog
Properties:

Derive from current
Permit branch
Branch none
Floating confiquration

2.4

PART II: QUICK STRUCTURE REFERENCE

Since StarTeam is a tool used by many people at the same time, a common
structure must be established. This standard structure will ensure that all
StarTeam projects will look and behave in the same way. This is very
important since StarTeam can be used in a number of different ways.

PROJECTS

For small/moderate projects, the local department name should be used as
StarTeam-project title. Larger projects must acquire their own StarTeam-
project title. Contact your local StarTeam administrator for more information
on creating a separate StarTeam project.

FILE TYPES

Documents, drawing and source code relating to a project should be checked
into StarTeam.

STANDARD VIEWS:

The Project and Test-program views should always be created. Configuration
accordingly:

Dpen Project Wizard: Select View 2] =] View:

Mame of projectitestprogram

) Folder:

Wiew name: = Mame of projectitestprogram [# char]

=g
_____E;.E-'F‘miects RSAS Fropetties:
50 Mexus

) s Derive from current
Testprograms Yiew descriphion: Permit branch

: Ml eryw ]
=3 CAL 120 3521 [FGARS — Branch nons
- R~ ] Flaating configuration

Starleam”®

[ View:
Pro'ect Jis| Rewision view for project/testprogram

Wizar d Click Finizh to open your project. Folder. . .
Same as parent wiew folder with
_=revision™ appended.
Properties:

< Foregdende H&sta | Slutfior I Awbiygt Derive from current

Permit branch

Branch all
Labeled configuration

STANDARD FOLDERS

In order to simplify readability and access all project should have the same
base folder structure. It is recommended to use the standard folder, however
extensions and modifications must be allowed to ensure flexibility.
Recommended standard folders:
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Ooc folder.

Should contain
documents relating to

the project. Can contain e

suitable subfolder.

= [:l Mexuz

-] Doc
£l (20 Imstall

Install folder.
[ontains to
subfolders: Files and
Installshield.

LABELS

.

[:| Files
2 InstallShield

Testprograms

~

Files folder.

Should contain all files needed to
install software. Contains subfolders
if more than ane program belongs to
the project.

Contains installshield packages of files
located in the Files folder.

Source folder.

Lontains source code associated with the
projects. [ontains subtolders if more than
one program belongs to the project.

The only type of label that should be used is View Labels. These must be
attached at the project or test-program level in the view hierarchy. In the View
example above, labels should only be attached to the Nexus and CAL 120

352/1 views.



